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LIMITED WARRANTY
ABI (“Manufacturer”) warrants this product (the “Products”) as follows:

PERTAINING TO HARDWARE

1.  Limited Warranty.
Manufacturer warrants that the Products sold hereunder will be free from defects
in material and workmanship for a period of ONE (1) YEAR from the date of
purchase.  If the Products do not conform to this Limited Warranty during the
warranty period (as herein above specified), Buyer shall notify Manufacturer in
writing of the claimed defects and demonstrate to Manufacturer satisfaction that
said defects are covered by this Limited Warranty.  If the defects are properly
reported to Manufacturer within the warranty period, and the defects are of such
type and nature as to be covered by this warranty, Manufacturer shall, at its own
expense, furnish, replacement Products or, at Manufacturer’s option, replacement
parts for the defective Products. Manufacturer may use remanufactured, refurbished,
or used parts and modules in making warranty repairs. Shipping and installation of
the replacement Products or replacement parts shall be at Buyer’s expense.

2.  Other Limits .
THE FOREGOING IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WAR-
RANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE.  Manufacturer does not warrant against damages or defects arising out
of improper or abnormal use of handling of the Products; against defects or dam-
ages arising from improper installation (where installation is by persons other than
Manufacturer), against defects in products or components not manufactured by
Manufacturer, or against damages resulting from such non-Manufacturer made
products or components.  Manufacturer passes on to Buyer the warranty it re-
ceived (if any) from the maker thereof of such non-Manufacturer made products or
components.  This warranty also does not apply to Products upon which repairs
have been effected or attempted by persons other than pursuant to written authori-
zation by Manufacturer; or if any Manufacturer serial number has been removed
or defaced.

3.  Exclusive Obligation.
THIS WARRANTY IS EXCLUSIVE.   The sole and exclusive obligation of Manu-
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facturer shall be to repair or replace the defective Products in the manner and for
the period provided above.  Manufacturer shall not have any other obligation with
respect to the Products or any part thereof, whether based on contract, tort, strict
liability or otherwise.  Under no circumstances, whether based on this Limited
Warranty or otherwise, shall Manufacturer be liable for incidental, special, conse-
quential damages, or under any legal theory, including lost profits or savings, dam-
age to or replacement of equipment and property, and any cost of recovering pro-
gramming, of reprogramming, or of reproducing any program or data stored in or
used with Products.

4.  Other Statements.
Manufacturer’s employees or representatives’ ORAL OR OTHER WRITTEN
STATEMENTS DO NOT CONSTITUTE WARRANTIES, shall not be relied upon
by Buyer, and are not a part of the contract for sale or this limited warranty.

5.  Entir e Obligation.
This Limited Warranty states the entire obligation of Manufacturer with respect to
the Products.  If any part of this Limited Warranty is determined to be void or
illegal, the remainder shall remain in full force and effect.

PERTAINING TO SOFTWARE AND DOCUMENTATION

Manufacturer has tested the software and reviewed the accuracy of this documen-
tation. Manufacturer makes no warranty or representation, either expressed or im-
plied, with respect to its software and documentation. As a result, this software and
documentation are sold "as is", and you, the Buyer, are assuming the entire risk as
to their quality and performance.

30-DAY MONEY-BACK
GUARANTEE
ABI products are sold with a 30-day money-back guarantee. If you are not com-
pletely satisfied with the product, return the entire package to the place of original
purchase within 30 days of receipt for a full refund of your purchase price (exclud-
ing any shipping, handling, or transportation charges).
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INTRODUCTION

OVERVIEW

ABI's µU•REm hardware and software combination provide an affordable ROM/
RAM emulation system for the PC Compatible family of computers.

The µU•REm system allows you to quickly download and test your code: from 2
Kbyte to 8 Mbyte in 8 bit or 16 bit width. Your code can be viewed and easily
edited to see the results of  your changes instantly.

The µU•REm system is expandable. The emulation memory space can be easily
increased by simply adding additional SRAM or by adding another memory card.

The µU•REm system is flexible. The available standard target adapters (for all
common EPROMs and PROMs) and custom adapters for specific systems will
meet the needs for a wide range of requirements.

Whether your code is large or small, the advantages µU•REm system offers will
greatly reduce your development time.

FEATURES

The µU•REm hardware and software offer a range of features:

• Emulates 8 or 16 bit data width (2716, 27C512, 27C800, ...) up to 8M-
bytes per unit

• Combine up to four units for 64 bit emulation

• Two proprietary slots for multiple memory cards and future expansion

• Separate 8 and 8/16 bit target interface connectors

• Both TTL and CMOS input/output compatible

• No external power needed (powered by host)

• Easily expandable by simply adding additional SRAM

• 3V lithium battery backup
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• High speed data transfer: downloads 1M-byte in under 2 seconds (hard
drive to emulator)

• Access time: approx. 30 ns plus SRAM speed

• Target controlled data width (on 8/16 bit connector)

• I/O lines: 2 (1 RESET) open-collector outputs, and 1 bidirectional

• Target write access to emulation memory or secondary space using addi-
tional memory card

• View and edit any address range or individual bytes instantly

• Monitor and modify I/O lines

• Download and upload with verify

• Control multiple emulators seamlessly under one environment with intel-
ligent 16/32/64 bit file splits

• Automatically sets RESET line HIGH, LOW, or no-action on host access
with adjustable delay

SYSTEM REQUIREMENTS

The µU•REm system requires the following:

• PC Compatible with a free expansion slot

• 512 Kbyte of RAM

• MS-DOS, Version 3.3 or greater

• One floppy disk drive
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µU•REm PACKAGE

The µU•REm package contains:

• the Host Interface Card

• the Desktop Unit

• the Memory Card

• two 40-pin ribbon cables

• one 50-pin ribbon cable

• the URE-40A Target Adapter

• the URE-51A Target Adapter

• DIP headers (one of each): assorted sizes

• one RED Test Lead

• the µU•REm Program disk

• the µU•REm User's Guide and Reference Manual

• the Registration Card
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HARDWARE SETUP
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HARDWARE INSTALLATION

Refer to Fig. 2-1 and Fig. 2-2 during installation.

Install the Host Interface Card.

1. Turn OFF your computer.
2. Remove the cover from your computer.
3. Touch the chassis of the computer to discharge any static charges.
4. Firmly press the Host Interface Card into an available slot and

secure to chassis.
5. Replace the computer cover.

Next, connect the Host Interface Card to the Desktop Unit.

6. Connect the 40-pin ribbon cable to the Host Interface Connector
on the Desktop Unit Desktop Unit (J7 in Fig. 2-1).  Pin 1 is
marked red or blue strip on the ribbon cable.

7. Connect the other end of the 40-pin ribbon cable to the Host
Interface Card with pin 1 toward the top edge of the card.

Then, insert the Memory Card.

8. Insert the Memory Card into Expansion SLOT 0 (J1 in Fig. 2-1)
with the front facing the Target Connectors J3 and J4. The front
side of the Memory Card is the side with the 3V lithium battery.

Finally, connect the Target Adapter.

9. Connect the appropriate Target Adapter to the Target Connector
(J3 or J4 in Fig. 2-1) on the Desktop Unit with the correspond-
ing ribbon cable. See Appendix B for information on Target
Adapters pinouts.

10. Insert the DIP header with the same pin count as the target into
the Target Adapter. If an exact matching DIP header is not avail-
able, use the next larger header.

11. Carefully insert the Target Adapter into the target unit.
12. Clip one end of the supplied red test lead to the pin labeled  IN
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on the Target Adapter (see Fig. 2-3).
13. Clip the free end of the red test lead to the target’s VCC at an

easily accessible area on the target unit. The state of target’s
VCC is displayed in the ‘IN: User’ field on the application main
screen. IMPORTANT: emulator will not function if the red test
lead is not connected to target’s VCC.
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WE

GBT

OUT
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IN

WE
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FIGURE 2-3. RED TEST LEAD CONNECTION

m
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HARDWARE CONFIGURATION

The µU•REm hardware occupies 16 consecutive addresses starting at the base I/O
address of 300h (default), 310h, 320h, or 330h. In addition to the I/O address, 16
Kbytes of memory space in the Upper Memory Block (UMB) region starting at
D400:0000 or DC00:0000 (default) is used for data transfer. To prevent DOS and
WINDOWS operating systems from attempting to use this UMB range, add the
following to exclude the UMB range.

For DOS or Win3.x:

Add the following statement to the EMM386.EXE device driver line in
the CONFIG.SYS file:

X=DC00-DFFF
or

X=D400-D7FF

For Win9x:

Open Control Panel->System->Device Manager->Computer->Reserve
Resources->Memory and add range DC000 to DFFFF (or D4000 to
D7FFF), note the extra '0' and 'F'; open Control Panel->System->Device
Manager->Computer->Reserve Resources->Input/Output (I/O) and add
range 300 to 30F (or appropriate range). m Remove any EMM386.EXE
call from the CONFIG.SYS file.

For more information about excluding memory ranges, refer to your Operating
System manual.
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FIGURE 2-5. UMB ADDRESS JUMPER
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FIGURE 2-4. I/O BASE ADDRESS JUMPERS

To change the I/O base address, set the jumpers at J5 as shown in Fig. 2-4.

To change the UMB address, set the jumper at J6 as shown in Fig. 2-5.

m In multiple emulation systems installation, each unit must have a unique I/O
base address but all units must share a common UMB address.
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SOFTWARE SETUP

SOFTWARE INSTALLATION

For DOS or Win3.x:

The µU•REm software may be installed in any directory or in its own direc-
tory. To install the software, enter the following at the DOS prompt:

C:\>md uurem  <Enter>
C:\>cd uurem  <Enter>
C:\UUREM>copy a:\DOS_Win3x\*.*  <Enter>

The name of the directory in which the software was installed may be added
to the PATH statement in the AUTOEXEC.BAT file to simplify program ex-
ecution:

PATH=C:\DOS;C:\WINDOWS;C:\UUREM;

For Win9x or WinNT :

To install the software, RUN the following:

A:\Win9x_NT\SETUP.EXE  <Enter>

m Installation requires user to be logged in with FULL Administrator privi-
leges. System must also be rebooted after installation is complete.

SOFTWARE CONFIGURATION

From the appropriate directory, enter the following to run the µU•REm software:

uurem

If the default I/O base address (300h) was unchanged during Hardware Configura-
tion, the program will begin initialization. Otherwise, an error message will appear
and you will have a chance to enter the new I/O base address.
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FIGURE 3-2. I/O ADDRESS SETUP WINDOW

FIGURE 3-1. EMULATOR NOT FOUND

Select the correct address for each installed unit. The UMB address is automati-
cally detected when the correct I/O base address is set.

MULTIPLE EMULATION SYSTEMS INSTALLATION

Define I/O base address for each additional Emulator in “Options - I/O Port...”
menu.

Selecting OK will bring up the I/O base address setup window.
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MENU BAR

OUT AREA

FIGURE 5-1. MAIN SCREEN

Menu Bar The Menu Bar shows the available menus.

Title Bar The Title Bar shows the name of the current file.

View/Edit Area The View/Edit Area is for viewing and editing of the emulation
memory contents.

Size Area The Size Area shows the current size and width of the emulator.

Out Area The Out Area shows the current state of each user output line.

In Area The In Area shows the current state of each user input line.

IN AREASIZE AREA

VIEW/EDIT AREATITLE BAR

USING µU•REm

After starting the µU•REm software, the Main Screen will be shown:



CHAPTER 4

4-2 USING µU•REm

MOVING AROUND

Use the following keys to move between each screen area:

Tab/Shift-Tab Use the Tab/Shift-Tab keys to select between each group of items
on the screen.

Arrow Use the Arrow keys to select items within a group.

Enter Use the Enter key to confirm a selection or to toggle the state of
an item.

Space-bar Use the Space-bar to toggle the state of an item.

Alt + <key> Use the Alt + highlighted letter of an item to select that item.

SELECTING EMULATION SIZE

Select Size from the Options menu and the Size Setup window will appear.

FIGURE 4-2. SIZE SETUP WINDOW
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Enter the new size in the Size field: size must be in kilobyte units. If the entered
size is unavailable, the next available larger size will be selected. Next, select the
Data Width and Mode. In the 8 Bit emulation mode, the 40-Pin Target Connector
is used; in the 16 Bit mode, the 50-Pin Target Connector is used. It is important to
note that the target adapter be connected to the correct connector.

The Advanced button provides more flexibility in setting up the emulation memory.

FIGURE 4-3. ADVANCED SETUP WINDOW

The emulation memory can be configured as ROM or RAM—in systems with two
memory cards, the second card can be used as a "scratch-pad" RAM area.

The list of choices for the second memory card only becomes available when a
valid size is selected for the first card. If the second memory card size list is empty,
scroll down the list of sizes for the first card until sizes for the second card appears.
The Advanced button is disabled in systems with multiple emulators.
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SETTING THE ENVIRONMENT

Selecting Environment from the Options menu will bring up the Environment win-
dow.

ROM Addressable Range Only The ROM Addressable Range Only op-
tion limits the View/Edit range to that of
the emulation memory size.

Printing Characters Only The Printing Characters Only option lim-
its display of printing characters in the
ASCII portion of the View/Edit area. All
graphic characters are suppressed.

Swap Adjacent Bytes The Swap Adjacent Bytes option makes
data more easily readable. This option
does not affect how data is loaded.

FIGURE 4-4. ENVIRONMENT WINDOW
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Set Reset Line The Set Reset Line group establishes the
link between the Reset line and host ac-
cess to emulation memory.

Hold Reset Before Access The Hold Reset Before Access field de-
fines how long , in 1ms increments, the
Reset line should be held before host ini-
tiates access to emulation memory.

External The External provides definition of call
to external applications for pre/post pro-
cessing of data.

EDITING DATA

To edit data, select the View/Edit area and move the cursor to the desired location.
Type in the changes and press Enter to update the emulation memory. Use the
following keys while in the View/Edit area:

F2 Switch between Hex and ASCII areas.

Shift-F2 Toggle ASCII display filter.

Home Moves cursor to beginning of current line.

End Moves cursor to end of current line.

PgUp Move to previous page.

PgDn Move to next page.

Ctrl-Home Moves cursor to beginning of current page.

Ctrl-End Moves cursor to end of current page.

Ctrl-PgUp Moves cursor to address: 000000.

Ctrl-PgDn Moves cursor to end of addressable range.
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LOADING FILES

Select Load from the File menu and the Load Setup window appears.

Start Load The Start Load field defines the address in the emula-
tion memory space at which loading begins.

Blank Fill The Blank Fill option, when enabled, fills unloaded area
of the emulation memory with the value in the text box.

Swap Adjacent Bytes The Swap Adjacent Bytes option, when enabled, will
physically swap adjacent bytes before loading.

File Format The File Format specifies the format of the data file:
Binary, Intel-hex, Motorola S-record, or External call
for data pre-processing.

Split The Split list lists the available split formats. Auto-Split
is only available when two or four emulators are in use
at once.

FIGURE 4-5. LOAD SETUP WINDOW
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Select OK after setup is complete and a window for selecting a file to load will
appear.

FIGURE 4-6. LOAD FILE WINDOW
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FIGURE 4-7. DATA SPLIT FOR SYSTEM WITH TWO EMULATORS IN 8 BIT MODE

FIGURE 4-8. DATA SPLIT FOR SYSTEM WITH FOUR EMULATORS IN 8 BIT MODE
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The following figures show how Auto-Split splits and loads data into each emula-
tor. When None is selected in Split list when multiple units are used, emulation
memory in all attached units are treated as one contiguous space: data is loaded in
a continuous stream..
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FIGURE 4-10. DATA SPLIT FOR SYSTEM WITH FOUR EMULATORS IN 16 BIT MODE

FIGURE 4-9. DATA SPLIT FOR SYSTEM WITH TWO EMULATORS IN 16 BIT MODE

Data in the View/Edit area appears as in the original data file. All data splits occur
transparently.
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CONTROLLING USER I/O LINES

State of two (Reset and User) open-collector output lines and one (GBit) bidirec-
tional line can be manually toggled by selecting the desired line and pressing Enter
or the space-bar in the Out area.

FIGURE 4-11. USER OUT LINES

The state of the Reset line may change if the Set Reset Line option in the Environ-
ment window is set.

The state of the user input lines are monitored and updated approximately every
100ms in the In area (User: field reflects the power state of the Target System).

FIGURE 4-12a. USER IN LINES

It is important to note that for any input to register on the GBit input line, its output
control must be set high (or open state). The status of the GBit input will show
LOCK whenever the GBit output is set LOW as a reminder.

FIGURE 4-12b. USER IN LINES
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SAVING FILES

Select Save As from the File menu and the Save Setup window will appear.

Enter the From and the To address range of the desired emulation memory space in
their respective fields, select File Format, then select OK. Next, enter the new file
name, drive, and directory in the Save File window.

FIGURE 4-13. SAVE SETUP WINDOW

FIGURE 4-14. SAVE FILE WINDOW
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IMPORTANT NOTE:

Under certain condition, scrolling up or down in the VIEW/EDIT
area while emulating will cause the target unit to reset (when RESET
line is connected) or freeze. This is a normal occurrence resulting
from the host PC temporarily taking control of the shared emulation
memory space from the target unit to read additional data when a 16
Kbyte boundary is crossed.
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A-1COMMAND REFERENCE

COMMAND REFERENCE

ABOUT MENU COMMANDS

FIGURE A-1. ABOUT MENU

About The About command gives the current software version.

Info The Info command gives the current configuration and system
addresses of the emulation system.
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FILE MENU COMMANDS

FIGURE A-2. FILE MENU

New The New command prepares the emulation memory for data.

Load The Load command loads an existing file. When Load is cho-
sen, the Load Setup window with options for specifying load
address, blank fill, file format, and split format appears.

Auto Load The Auto Load command monitors a data file for change and
automatically load when change is detected. When Auto Load is
chosen, the Load Setup window with options for specifying load
address, blank fill, file format, and split format appears.

Save The Save command saves the content of the emulation memory
to disk, replacing the most recent version of file with the same
name.

Save As The Save As command saves the content of the emulation
memory to disk under a new name. When Save As is chosen, the
Save Setup window with options for specifying From and To
addresses and file format appears.

DOS Shell The DOS Shell command temporarily leaves the µU•REm soft-
ware and exits to the DOS prompt. Enter EXIT from the DOS
prompt to continue.

Quit The Quit command ends the program and returns to the operat-
ing system. If any unsaved changes remain, a window will ap-
pear to ask if changes need to be saved.

Win9x/NT
version ONLY
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SEARCH MENU COMMANDS

FIGURE A-3. SEARCH MENU

Find Hex The Find Hex command searches the emulation memory for a
matching hexadecimal sequence. Find Hex will search to the
end of the View/Edit addressable range.

Find ASCII The Find ASCII command searches the emulation memory for a
matching text string. Find ASCII will search to the end of the
View/Edit addressable range.

Search Again The Search Again command repeats the last successful search
of the emulation memory for the next occurrence.

Go To The Go To  command moves the cursor in the View/Edit area to
the specified address.
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OPTIONS MENU COMMANDS

FIGURE A-4. OPTIONS MENU

Size The Size command presents a window for specifying size and
width of the emulation memory.

Verify Load The Verify Load command verifies the integrity of the data dur-
ing load operations.

Verify Save The Verify Save command verifies the integrity of the data dur-
ing save operations.

I/O Port The I/O Port command presents a window for defining I/O base
address for each attached emulator.

Environment The Environment command presents a window for specifying
range and appearance of the View/Edit area and Reset link to
host access.

Ins/Rmv Card The Ins/Rmv Card command removes power to the emulator
expansion slots to allow insertion or removal of cards.

Refresh The Refresh command updates the display in the View/Edit area
with the content of  the emulation memory.
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FIGURE B-1. 40-PIN CONNECTOR LOCATION FIGURE B-2. 40-PIN CONNECTOR PINOUT

PINOUTS

40-PIN TARGET CONNECTOR

The 40-Pin Target Connector (J4) is located on the desktop unit, shown in Fig. B-1.
Attach the appropriate target adapter to this connector when emulation system is
in 8 bit mode.
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(5)
(7)
(9)
(11)
(13)
(15)
(17)
(19)
(21)
(23)
(25)
(27)
(29)
(31)
(33)
(35)
(37)
(39)

GND
RESET

WE
A22
A21
A18
A17
A14
A13

A8
A9

A11
OE

A10
CE
D7
D6
D5
D4
D3

OUT
IN
GBIT
A20
A19
A16
A15
A12
A7
A6
A5
A4
A3
A2
A1
A0
D0
D1
D2
GND

(2)
(4)
(6)
(8)

(10)
(12)
(14)
(16)
(18)
(20)
(22)
(24)
(26)
(28)
(30)
(32)
(34)
(36)
(38)
(40)

J4J3
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50-PIN TARGET CONNECTOR

The 50-Pin Target Connector (J3) is located on the desktop unit, shown in Fig. B-3.
Attach the appropriate target adapter to this connector when emulation system is
in 16 bit mode. Signal A0 (pin 3) is used to select HIGH/LOW byte when signal
BHE (pin 29) is LOW. An alternate pin designation of address lines are shown in
italic; this may be more helpful if the manufacturer of the target device uses a
different method of designating address lines.

FIGURE B-3. 50-PIN CONNECTOR LOCATION
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FIGURE B-4. 50-PIN CONNECTOR PINOUT
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FIGURE B-5. URE-40A TARGET ADAPTER

TARGET ADAPTERS

The URE-40A adapter conforms to JEDEC standard for 8 bit EPROM. This adapter
is pin compatible with common 8 bit wide EPROMs (27C16, 27C64, ... , 27C080)
and other devices with the same pin configuration. Connect this adapter to the 40-
Pin Target Connector with a 40-pin ribbon cable and set the µU•REm program in 8
bit mode.
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Pin 34 is VCC.

These lines are monitored 
in µU•REm program.

*NOTE:
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The URE-50A adapter conforms to JEDEC standard for 16 bit EPROM. This adapter
is pin compatible with common 8/16 bit wide EPROMs (27C400, 27C800, ...) and
other devices with the same pin configuration. The BHE (Byte High Enable) pin is
used to select between 8 and 16 bit modes. Connect this adapter to the 50-Pin
Target Connector with a 50-pin ribbon cable and set the µU•REm program in 16
bit mode. An alternate pin designation of address lines are shown in italic; this may
be more helpful if the manufacturer of the target device uses a different method of
designating address lines.

FIGURE B-6. URE-50A TARGET ADAPTER
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POWER connector 
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POD.
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The URE-51A adapter conforms to JEDEC standard for 16 bit EPROM. This adapter
is pin compatible with common 16 bit wide EPROMs (27C1024, 27C4096) and
other devices with the same pin configuration. Connect this adapter to the 50-Pin
Target Connector with a 50-pin ribbon cable and set the µU•REm program in 16
bit mode. An alternate pin designation of address lines are shown in italic; this may
be more helpful if the manufacturer of the target device uses a different method of
designating address lines.

FIGURE B-7. URE-51A TARGET ADAPTER
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C-1MEMORY MAPS

MEMORY MAPS

Three types of memory cards are available: 2M-byte (Group 1) memory card, 2M-
byte (Group 2) memory card, and 8M-byte memory card. The following diagrams
show the memory maps for possible combinations of memory cards installed in
the system; diagrams for one installed memory card also apply to systems with
two installed memory cards with one disabled.

FIGURE C-1. ONE 2M-BYTE (GRP.1) CARD

FIGURE C-2. TWO 2M-BYTE(GRP.1) CARDS
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FIGURE C-3. ONE 2M-BYTE (GRP.1) & ONE 2M-BYTE (GRP.2) CARDS

FIGURE C-4. ONE 8M-BYTE CARD
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FIGURE C-5. TWO 8M-BYTE CARDS
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FIGURE C-6. ONE 8M-BYTE & ONE 2M-BYTE (GRP.2) CARDS
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D-1ADDING MEMORY

FIGURE D-1. ADDING MEMORY SEQUENCE

U4
U3
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U14
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1024KB
1280KB
1536KB
1792KB
2048KB

2M CARD 8M CARD ADD SET

ADDING MEMORY

The emulation memory space can be easily increased by adding additional SRAMs.
The 2M-byte (Grp. 1 & 2) cards require 128K x 8 SRAM: SAMSUNG
KM681000BLP or equivalent. The 8M-byte card requires 512K x 8 SRAM:
SAMSUNG KM684000LP or equivalent. All memory MUST have the same ac-
cess time. The shaded area in Figure D-1 is for parts located on the backside of the
memory card. Memory is added in sets of twos as shown in the following table:
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